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Introduction

This User Guide describes the installation and features of Xerox
CentreWare for Hewlett Packard OpenView NNM, Version 1.x. As an 
enterprise network management application, HP NNM provides 
the ability to view and centrally manage network resources. With
the addition of the CentreWare Snap-In for OpenView NNM, this 
application can additionally provide the status of several types o
Xerox devices on the network.

When successfully installed, you will be able to view all of the 
discovered Xerox network devices under one map in OpenView NNM.

In addition, CentreWare for HP NNM enables HP NNM to:

• Discover Xerox networked devices with HP NNM

• Provide special status and notifications to HP NNM users 
about Xerox devices. Device status will be enhanced by a rich 
MIB data set available via web server in certain Xerox 
networked devices.

• Display standard HP NNM Color Coding for the Xerox Printer 
Agent icon 

• Automatically notify the user about Xerox device events and 
problems through the use of SNMP event traps

• Launch CentreWare Internet Services using a standard web 
browser.
Note: This assumes all Xerox networked devices will include
Embedded Web Server.
4 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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How to use this
Document

This document assumes that you have a working knowledge an
familiarity with HP NNM. Only procedures that result from the 
installation of the CentreWare for HP NNM snap-in are 
described.

You may print all or part of this document at any time from your 
Adobe Acrobat reader by clicking the File menu and then selecting
Print . You may then select a single page, a range of pages, or t
entire document for printing.

For initial installation

Read and follow these sections:

1 CentreWare for HP OpenView Software Installation

For day-to-day tasks

Read and follow these sections:

1 Using CentreWare for HP NNM 

2 Troubleshooting
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 5
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Key Benefits and
Features

System Requirements Hardware Requirements

This solution modifies existing HP NNM files and adds a few 
small files to your hard disk. The total hardware requirements are
follows:

• Pentium PC

• Minimum 64 Megabytes RAM

• Minimum 5 Megabytes Hard Disk Space

Feature Benefits

Device Discovery Provides the automatic identification of Xerox devices on your netwo
and presents them with recognizable icons.

Color-Coded Device Status Automatically changes the color in the device icon to reflect the dev
status in the Xerox Printers Map. IP map status is not effected.

Access to the device embedded web 
server, CentreWare Internet Services

If your device contains an embedded web server (CentreWare Interne
Services), you can easily access it by selecting Server  Home Page 
under the OpenView Tools menu Web Browser selection.

Custom Domain for Xerox Devices Managing the Xerox devices on your network is made much easier
displaying all the discovered Xerox devices in a single domain.

SNMP Trap Support Provides option for registering with Xerox networked devices for SNM
Trap.
6 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE



Introduction
Software Requirements

The following software must be installed on your PC before 
installing CentreWare for HP OpenView NNM.

• Windows NT 4.0 with Service Pack 3.0 or later

• HP OpenView NNM  Version 6.0, or later

• Microsoft Internet Explorer 4.1, or greater - OR - Netscape 
Navigator v4.0 or greater.

Before You Start
CentreWare for HP

OpenView NNM

Connect your device to an active network with appropriate cabling. 
Ensure the device has a valid, unique IP address.
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 7
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CentreWare for HP OpenView NNM
Software Installation

Web Installation The lastest version of CentreWare for HP OpenView NNM is available
from the Xerox Website at:

http://www.xerox.com/hpopenview.

Perform the following steps to install CentreWare for HP 
OpenView NNM:

1 After downloading the file to a temporary folder, double click on 
the icon to extract the files.

2 Double click on the file setup.exe.

3 The software will begin the installation process. After a few 
moments, the Install Shield Wizard will load.

4 This software must be installed in the same folder that contains  
HP OpenView NNM. If the folder shown is incorrect, select the 
Browse button and select the correct folder, then select Next.

5 Select Next again to begin. The necessary files in your HP 
OpenView environment will be modified and copied to the select
folder along with any additional files required.

6 The installation process will take some time to complete. Follow
the instructions on your screen.

7 When the install  is complete, start HP OpenView NNM.
8 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE

http://www.xerox.com/hpopenview


Using CentreWare for HP OpenView NNM
Using CentreWare for HP OpenView NNM
This section describes the features of HP NNM made available 
by the installation of CentreWare for HP NNM. Only those 
features of OpenView that are directly related to the CentreWare 
functionality will be described. For additional information on HP 
OpenView NNM, go to the OpenView Home page at:

http://www.openview.hp.com

The HP OpenView
NNM Interface

An example of the HP NNM User Interface is shown in the 
figure below. Note that the standard features of the application are 
accessed via the Menu bar at the top if the display, and the Tool bar 
situated below it.

Icons

Tool Bar and Menu Bar
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 9
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On this display, there are two domains displayed on the “map” t
is the work space for the OpenView application. Of these two 
domains, only the Xerox Printers domain was generated by 
CentreWare for HP OpenView NNM.

NOTE: The background of the work space is selectable by the u
Not all OpenView installations will utili ze a map of the United 
States for their background scheme.

The CentreWare generated Xerox Printers domain represents a
the Xerox devices that were discovered on the network. Double
clicking this icon will cause these devices to be displayed in a m
view that shows each Xerox device with Xerox status. 

If this icon is right-clicked, a secondary dialog is displayed by 
selecting Xerox Device Display from the resulting menu. The 
dialog is shown below. It is used to provide statistics including th
number of devices found under the Xerox Printers icon, and the
status.

Device Discovery HP OpenView provides the discovery of Xerox devices. 
CentreWare for HP OpenView NNM additionally enables the 
identification of these device types as Xerox devices and the 
assignment of a unique Xerox icon to them.
10 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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Xerox Device Icons CentreWare for HP OpenView uses two icons to represent 
individual Xerox devices. The icons for these devices are:

Xerox Printers - This icon represents those devices that are 
printers only. An example might be one of the Xerox N-Series 
printers.

Xerox Multifunctional Devices - This icon represents devices tha
have more than just printing capability. The features of these 
devices may include copying, network scanning, and faxing. An
example of this type of device is the Xerox Document Centre 
products.

Xerox Printer Agent Icon

When double-clicked, the Xerox Printers icon or Xerox 
Multifunctional device icon will display another icon called the 
Xerox Printer Agent icon. Like the other icons in HP OpenView NNM
this icon will change when the status of the device changes. The
function of this icon is to monitor alarms from the Xerox device an
report them to HP OpenView NNM. This icon is created when 
CentreWare for HP OpenView NNM is installed. It is the only icon wh
color is controlled by the CentreWare Snap-in. 
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 11
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Color-Coded Device
Status

The Xerox Printer Agent icon will be color-coded to represent th
current status of the device. The color-coded status is provided 
the xrxstatus.dll utility, for the Xerox Printers map. 

The color of the icon is determined by the return code from the 
device. Under the control of HP OpenView NNM, the color will also 
propagate to the top of the network, providing top level indicatio
of problems that exist at lower levels in the map structure. This 
propagation is controlled by HP OpenView NNM, not the CentreWare 
Snap-in. IP map icons do not propagate the Agent status.  

The relation between the color-code and the device status is 
presented in the following table.

Menu Items for Xerox
Devices

There are OpenView NNM menu items that are created when 
CentreWare for HP NNM is installed. These menu items reside 
on the Tools menu on the OpenView NNM Menu bar.

Web Browser  Menu Item

Many Xerox devices contain embedded web servers. HP NNM
automatically detects whether a device contains one and launches 
CentreWare Internet Services though the Server Home Page menu 
selection. 

Internet Services provides a variety of features for configuring a
monitoring your device. 

Xerox Printer Agent Color

Critical Red

Warning Light Blue

Other, or no alert Green
12 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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Consult the manuals and CDs delivered with your device for deta
on Xerox CentreWare Internet Services. The Web Browser men
item is used to launch CentreWare Internet Services for the sele
device. To use this feature perform the following steps:

1 Select a Xerox device.

2 Select the Tools menu, Web Browser, and Server Home Page.

3 The default web browser for the workstation will be launched, an
CentreWare Internet Services for the device will be displayed.

Xerox Trap Registration Menu Item

The Xerox Trap Registration menu item will allow the user to sele
and enable the type of trap configuration desired for the managi
workstation. Traps are used to provide an alert the instant an erro
the device occurs, rather than waiting for the next status poll. Th
also provide more detailed troubleshooting information when a 
device is experiencing a problem.

There are two possible selections for Trap Registration. With Single 
Selection, the user selects a specific Xerox device. Only the dev
selected will be registered. Any alerts for that device will be seen
the managing workstation’s All Alarms Browser. 

With the Auto Trap Configuration  the managing workstation is 
registered at all discovered Xerox networked devices to receive 
traps. As with Single Selection, any alerts for the devices are se
in the managing workstation’s All Alarms Browser. 
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 13
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USING SINGLE SELECTION

This trap configuration registers the selected device. Only one 
device can be selected at a time.

To use the Single Selection configuration, perform the following 
steps:

1 Select a Xerox device.

2 Select the Tools menu, Xerox Trap Registration, and Single 
Selection.

3 The Xerox device will be configured to recognize the managing 
workstation.

4 The SNMP information for that device will be captured and 
displayed in the All Alarms Browser for the managing workstatio

USING AUTO TRAP CONFIGURATION

In the Auto Trap Configuration, all discovered Xerox devices are
registered.

To use Auto Trap Configuration, perform the following steps:

1 Select a Xerox device.

2 Select the Tools menu, Xerox Trap Registration, and Auto Trap 
Configuration .

3 The managing workstation will be registered at all discovered an
managed Xerox networked devices.

4 The SNMP information for that device will be captured and 
displayed in the Alarm Browser for the managing workstation.
14 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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CONFIRMING SNMP TRAP REGISTRATION AT 
THE DEVICE

To confirm SNMP Trap Registration on a specific Xerox device, 
perform the following steps:

1 Select the Xerox device.

2 In HP OpenView, Select the Tools menu, Web Browser, and 
Server Home Page.

3 The default web browser for the workstation will be launched, an
CentreWare Internet Services for the device will be displayed.

4 Select the Properties tab.

5 Select Connectivity, Protocols and SNMP.

6 The screen shown below will be displayed.

The IP Address of the 
Managing Workstation 
will be shown here.
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 15
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SNMP MIB Browser Menu Item

The SNMP MIB Browser selection will display a MIB browser that
allows the user to search  for, select, view, and set values for MI
OIDs.

The MIB Browser is a standard  feature of the HP OpenView NNM 
application, and is not installed with CentreWare for HP NNM. 
However, when CentreWare for HP OpenView NNM is installed, the 
OIDs for Xerox networked devices are installed, and  can be viewed 
with the SNMP MIB Browser.

When the SNMP MIB Browser selection is made, a browser scre
like the one below is displayed.

Using this browser, the user can access any MIB OID in the 
configuration. The browser will then allow the user to view the 
contents of the OID for evaluation and troubleshooting.
16 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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MIBs Loaded During
Installation

In the following table is a list of the MIBs loaded during installatio
of CentreWare for HP OpenView NNM, accompanied by a brief 
description of the MIB.

NOTE: All Xerox devices support a subset of the included MIB 
modules.  IETF MIBs are supported by all Xerox devices.

Table 0.1 MIBs Loaded During Installation

MIB Name Description

02common_xrx.mv1 The root of the Xerox Common 
MIB module.

06gentc_xrx.mv1 Xerox General Textual 
Conventions

07gen_xrx.mv1 Xerox General MIB

10hosttc_xrx.mv1 The TC module for textual 
conventions, enumerated types, 
OIDs and other volatile elements 
of the companion Host Resources 
Extensions MIB ('xcmHrMIB'), 
which supports extended 
configuration and management of 
various host resources for network 
accessible host systems.  These 
modules augment and extend the 
original IETF Host Resources 
MIB (RFC 1514).
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 17
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11hostx_xrx.mv1 The MIB module for extended 
configuration and management 
of various host resources for 
network accessible host 
systems. This module 
augments and extends the 
original IETF Host Resources 
MIB (RFC 1514).

15prtxtc_xrx.mv1 Xerox Printer MIB Extensions 
Textual Conventions. This 
Module provides Xerox 
extensions of the IETF Printer 
MIB.

16prtx_xrx.mv1 Xerox Printer MIB Extensions 
Module. This Module provides 
extension to the IETF Printer 
MIB.

21rsrctc_xrx.mv1 XCMI Document Resources 
MIB Textual Conventions

22rsrc_xrx.mv1 Document Resources General
Group (Mandatory)

Table 0.1 MIBs Loaded During Installation

MIB Name Description
18 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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40jobtc_xrx.mv1 This textual-convention 
module defines textual 
conventions for use with the 
Job Monitoring MIB, module: 
XEROX-JOB-MONITORING
-MIB.  Also the explanatory 
material with this module 
explains the Job Monitoring 
MIB.  These 
textual-conventions and 
explanations are in a separate 
module from the Job 
Monitoring MIB, so that they 
may be republished when 
additional enums are added or 
more explanatory material is 
added without needing to 
republish the Job Monitoring 
MIB. This increase the 
stability of the Job Monitoring 
MIB.

41jobmon_xrx.mv1 This MIB specifies job and 
document objects for 
monitoring print jobs, 
including accounting of print 
jobs.  This MIB does not 
provide for management and 
control of print jobs, such as 
cancelling or modifying them.

Table 0.1 MIBs Loaded During Installation

MIB Name Description
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 19
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42jobmtc_xrx.mv1 Textual Conventions 
companion to the XCMI 
Simple Job Mgmt MIB, the 
MIB module for performing 
lightweight management of 
jobs in network accessible host 
systems.

43jobman_xrx.mv1 The MIB module for 
performing lightweight 
management of jobs in 
network accessible host 
systems.

50commtc_xrx.mv1 The TC module for textual 
conventions, enumerated types,
OIDs, and other volatile 
elements of the companion 
Communications Engine MIB, 
which supports detailed 
protocol stack graphing, and 
active management of 
communications protocol 
stacks, communications end 
system applications, 
communications intermediate 
systems, and communications 
gateways for network 
accessible host systems.

Table 0.1 MIBs Loaded During Installation

MIB Name Description
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51comms_xrx.mv1 The MIB module for detailed 
protocol stack graphing, and 
active management of 
communications protocol 
stacks, communications end 
system applications, 
communications intermediate 
systems, and communications 
gateways for network 
accessible host systems.

52conftc_xrx.mv1 The TC module for textual 
conventions, enumerated types,
OIDs, and other volatile 
elements of the companion 
Communications Config MIB, 
which supports active 
configuration discovery of 
communications end system 
applications, communications 
intermediate systems, and 
communications gateways for 
network accessible host 
systems.

53config_xrx.mv1 The MIB module which 
supports active configuration 
discovery of communications 
protocol stacks, 
communications end system 
applications, communications 
intermediate systems, and 
communications gateways for 
network accessible host 
systems.

Table 0.1 MIBs Loaded During Installation

MIB Name Description
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 21
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58svctc_xrx.mv1 Textual Conventions 
companion to XCMI Service 
Monitoring MIB, the MIB 
module for basic configuration 
and active management of 
application services for 
network accessible host 
systems.

59svcmon_xrx.mv1 The MIB module for basic 
configuration and active 
management of application 
services for network accessible 
host systems.

93pidtc_xrx.mv1 Product ID Module

RFC1213 IETF MIB II

RFC1514 IETF Host Resource MIB

RFC1759 IETF Printer MIB

RFC 1902,1903,1904 Allows compilation of SNMP 
v2 format mibs that were 
downgraded to V1 format.

Table 0.1 MIBs Loaded During Installation

MIB Name Description
22 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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Troubleshooting

If you have problems after you have installed CentreWare for HP 
OpenView NNM, consult the table below.

NOTE: Most errors generated by the CentreWare for HP OpenView NNM are logged in a log file. 
For more information, look into the log file (c:\OpenView\log\Xrx_Device_log.txt)

Symptoms Possible causes Solution

Installation gives a 
message box reading

“HP OpenView demand 
level is not set to All 
Levels. Please exit the 
setup, set the demand level 
to All Levels from the NNM 
GUI and then proceed with 
setup process.” and then 
exits.

The Demand level of the NNM 
application is not set to the 
appropriate value.

1. Before running the CentreWare install, open 
the NNM GUI.

2. From the menubar, click Map->Properties. It 
will open a new window named “Map 
Properties”

3. Click on the “Applications” tab, select IP Map 
from the List Box and press the button labelled
“Configure for this map”.  

4. Highlight the field named On-Demand: ….
5. Select “All Levels”.
6. Click the “Verify” button, and upon 

verification, press the “OK” button.
7. On the “Map Properties” click the “OK” 

button. It performs some configuration.
8. After the NNM completes configuration, close 

the NNM window. 
9. Begin the installation again.

A Xerox Device is not 
discovered.

The SNMP agent is not working 
properly in the node.

There is a problem with the 
network connectivity.

The Network in which the 
Device exists is unmanaged.

Ping the Document Centre.

Ping the Document Centre.

Contact the Network Administrator.

Xerox Device is still not 
discovered.

The sysObjectId entry in the 
/usr/ov/conf/oid_to_sym
/usr/ov/conf/oid_to_type
files is missing.

Make the sysObjectId entries in the files in the 
proper format.

Icon on the map is not the 
proper Xerox Device icon.

The object’s SysobjectId in the 
file oid_to_sym is not properly 
entered.

Make the sysObjectId entries in the oid_to_sym file
in the proper format.
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 23
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Appendix A – Xerox Installer / 
Un-Installer

Installer The installer is a simple install-shield application that will automa
the addition of the files and perform the required configuration.

The installer will copy bitmap images and registration files into th
HP NNM installation directory.  It will also edit several files to 
enable the identification of Xerox devices in HP OpenView NNM.

The modifications performed by the installer are as follows. The
installer will:

1 Edit the file c:\OpenView\conf\oid_to_type. The type list is given 
in Appendix B.

2 Edit the file c:\OpenView\conf\oid_to_sym. The device list is 
given in Appendix B.

3 Add new .exes and .dlls under c:\OpenView\bin directory.

4 Add new file xrx_fields under c:\OpenView\fields\c for Xerox 
device specific database fields.

5 Add new bitmaps for Xerox devices to the c:\OpenView\bitmaps\c 
folder and register them.

In the information below, the installation directory is given as 
C:\OpenView. The installation directory drive is selectable and m
be different for your installation.
24 ❖ XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE
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6 Add the new files to the c:\OpenView\symbols folder to add new 
Xerox printer device symbol class definitions.

7 Modify trapd.conf file under c:\OpenView\conf, to enable 
CentreWare to log traps received from Xerox Devices.

8 Create the domain Xerox Printers.

9 Copy the Xerox MIB files to 
c:\OpenView\snmp_mibs\vendor\Xerox.and load them.

Uninstaller To run the un-installer, use Add/Remove Programs in the 
Windows Control Panel. The un-installer will remove all files 
copied by the Installer, undo any file changes, and run the custo
executable XPlugin_Uninstall.exe. This will remove the Xerox 
printer icon, subclass definition, and the alarm object correspond
to CentreWare for HP OpenView NNM. It will additionally:

1 Remove the lines added to files during installation.

2 Delete all files copied.

3 Start services by executing ovstart.
XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE ❖ 25
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Appendix B - Type Definition Text

The Xerox Printer specific System Object Identifier entries to be
made in the files oid_to_sym and oid_to_type are (These lines a
appended to the end of the files):

1.3.6.1.4.1.253.8.62.1.2.2.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N17

1.3.6.1.4.1.253.8.62.1.2.3.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model NC60

1.3.6.1.4.1.253.8.62.1.2.3.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model NC60

1.3.6.1.4.1.253.8.62.1.3.3.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model NC1235

1.3.6.1.4.1.253.8.62.1.2.3.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model NC60

1.3.6.1.4.1.253.8.62.1.3.2.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N24/N32

1.3.6.1.4.1.253.8.62.1.3.2.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N24/N32

1.3.6.1.4.1.253.8.62.1.3.2.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N24

1.3.6.1.4.1.253.8.62.1.3.2.3.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N40

1.3.6.1.4.1.253.8.62.1.3.2.21.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N3225

1.3.6.1.4.1.253.8.62.1.3.2.21.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N3225

1.3.6.1.4.1.253.8.62.1.3.2.22.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N4025

1.3.6.1.4.1.253.8.62.1.3.2.22.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N4025

1.3.6.1.4.1.253.8.62.1.3.2.18.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N2125

1.3.6.1.4.1.253.8.62.1.3.2.18.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N2125
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1.3.6.1.4.1.253.8.62.1.3.2.20.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N2825

1.3.6.1.4.1.253.8.62.1.3.2.20.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N2825

1.3.6.1.4.1.253.8.62.1.3.2.17.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N2025

1.3.6.1.4.1.253.8.62.1.3.2.17.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N2025

1.3.6.1.4.1.253.8.62.1.1.8.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC220ST

1.3.6.1.4.1.253.8.62.1.1.3.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.3.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.3.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.3.1.4:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.3.1.5:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.3.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230LP

1.3.6.1.4.1.253.8.62.1.1.3.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230LP

1.3.6.1.4.1.253.8.62.1.1.3.2.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230LP

1.3.6.1.4.1.253.8.62.1.1.3.2.4:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230LP

1.3.6.1.4.1.253.8.62.1.1.3.2.5:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230LP

1.3.6.1.4.1.253.8.62.1.1.22.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.22.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST

1.3.6.1.4.1.253.8.62.1.1.22.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC230ST
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1.3.6.1.4.1.253.8.62.1.1.5.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC240ST

1.3.6.1.4.1.253.8.62.1.1.5.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC240ST

1.3.6.1.4.1.253.8.62.1.1.5.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC240ST

1.3.6.1.4.1.253.8.62.1.1.7.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC255LP

1.3.6.1.4.1.253.8.62.1.1.7.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC255LP

1.3.6.1.4.1.253.8.62.1.1.7.2.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC255LP

1.3.6.1.4.1.253.8.62.1.1.7.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC255ST

1.3.6.1.4.1.253.8.62.1.1.7.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC255ST

1.3.6.1.4.1.253.8.62.1.1.7.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC255ST

1.3.6.1.4.1.253.8.62.1.1.4.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC265LP

1.3.6.1.4.1.253.8.62.1.1.4.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC265LP

1.3.6.1.4.1.253.8.62.1.1.4.2.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC265LP

1.3.6.1.4.1.253.8.62.1.1.4.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC265ST

1.3.6.1.4.1.253.8.62.1.1.4.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC265ST

1.3.6.1.4.1.253.8.62.1.1.4.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC265ST

1.3.6.1.4.1.253.8.62.1.1.6.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC340ST

1.3.6.1.4.1.253.8.62.1.1.6.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC340ST

1.3.6.1.4.1.253.8.62.1.1.6.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC340ST
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1.3.6.1.4.1.253.8.62.1.1.6.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC340LP

1.3.6.1.4.1.253.8.62.1.1.6.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC340LP

1.3.6.1.4.1.253.8.62.1.1.6.2.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC340LP

1.3.6.1.4.1.253.8.62.1.1.9.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC332ST

1.3.6.1.4.1.253.8.62.1.1.9.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC332ST

1.3.6.1.4.1.253.8.62.1.1.9.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC332ST

1.3.6.1.4.1.253.8.62.1.1.9.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC332LP

1.3.6.1.4.1.253.8.62.1.1.9.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC332LP

1.3.6.1.4.1.253.8.62.1.1.9.2.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC332LP

1.3.6.1.4.1.253.8.62.1.1.19.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC420ST

1.3.6.1.4.1.253.8.62.1.1.19.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC420ST

1.3.6.1.4.1.253.8.62.1.1.19.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC420ST

1.3.6.1.4.1.253.8.62.1.1.20.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC432ST

1.3.6.1.4.1.253.8.62.1.1.20.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC432ST

1.3.6.1.4.1.253.8.62.1.1.20.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC432ST

1.3.6.1.4.1.253.8.62.1.1.21.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC440ST

1.3.6.1.4.1.253.8.62.1.1.21.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC440ST

1.3.6.1.4.1.253.8.62.1.1.21.1.3:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC440ST
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1.3.6.1.4.1.253.8.62.1.1.17.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC450

1.3.6.1.4.1.253.8.62.1.1.17.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC450

1.3.6.1.4.1.253.8.62.1.1.17.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC460

1.3.6.1.4.1.253.8.62.1.1.17.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC460

1.3.6.1.4.1.253.8.62.1.1.17.3.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC465

1.3.6.1.4.1.253.8.62.1.1.17.3.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC465

1.3.6.1.4.1.253.8.62.1.1.17.4.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC470

1.3.6.1.4.1.253.8.62.1.1.17.4.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC470

1.3.6.1.4.1.253.8.62.1.1.17.5.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC475

1.3.6.1.4.1.253.8.62.1.1.17.5.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC475

1.3.6.1.4.1.253.8.62.1.1.18.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC495

1.3.6.1.4.1.253.8.62.1.1.18.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC4110

1.3.6.1.4.1.253.8.62.1.1.23.1.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC480

1.3.6.1.4.1.253.8.62.1.1.23.1.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC480

1.3.6.1.4.1.253.8.62.1.1.23.2.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC485

1.3.6.1.4.1.253.8.62.1.1.23.2.2:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model DC485

1.3.6.1.4.1.253.8.62.1.3.2.36.1:Xerox:Xerox Printer Agent: # 
XeroxPrinter Model N4525
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